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Congratulations on choosing Attix5 Critical Data Storage.  We believe you will find Backup 
Professional to be the most secure, scalable and efficient solution in addressing the business 
risk associated with the protection of critical data in a distributed environment.  If you experience 
any difficulty during the installation of Backup Professional, please contact your software 
provider. 
 
Backup Professional Server Edition (SE) is a remote storage solution that utilises client/server 
architecture to securely replicate data from the client device to a central data server.  Data is 
compressed to minimise bandwidth utilisation and transferred using a secure SSL connection to 
the Storage Platform.  Data is stored in an encrypted format, using an encryption key known 
only to you. 
  
Attix5 Backup Professional minimises risk, maximises productivity and allows businesses to 
regain control of their most valuable asset ï their data.  
 

 
Backup Professional Server Edition manages the backup and retrieval of files and/or folders on 
your server.  Selected files are backed up to the Storage Platform that is installed on a remote 
server.  This is shown in the following diagram: 
 

 
 

Your Backup Client connects to a group on the Storage Platform during the installation.  The 
Group Administrator oversees all group members, using the Backup Monitor.  The Storage 
Platform administrator uses the Storage Platform Console to manage the entire Storage 
Platform, including all the different groups. 

1. Introduction 
______________________________________________________________________________ 

OVERVIEW  
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Operating System  
Á Microsoft Windows Server 2008 (System State plug-in not supported) 
Á Microsoft Windows Server 2003 (Incl. SBS bundles) 
Á Microsoft Windows 2000 Server (Incl. SBS bundles) 

 
Processor & Memory  
Á Required: Pentium III processor with 256MB memory above operating requirements 
Á Recommended: Processor and memory requirements increase with the amount of data 

protected by Server Edition:   

Amount of data Protected Recommended 
Processor 

Recommended Memory 

Less than 100GB Pentium III 500MHz 512MB 

200GB P4 entry level 512MB 

500GB P4 2.0GHz 1GB 

1TB Dual Xeon 3GHz 2GB 

 
Disk Space  
Á Required: 50 MB plus space for local cache. 
Á Recommended: Amount of free space equal to the backup account limit if Binary Patching 

is enabled.  The space requirement for Delta Blocking is considerably less.  Please refer to 
the Patching section in Chapter 4 for more information. 
File/Print Server:  The local cache can be as large as the total size of all files selected for 
backup.  A file selection of 10 GB may need up to 10 GB free space for the cache. 
Database:  Space is needed for the data dump, which can be as large as the database, 
as well space for the cache, which is compressed version of the database. Assuming 1:2 
compression on a 10GB database you are recommended to have 15GB (10GB for the 
dump and 5GB for the cache) free space available.  If the VSS plug-in is used, only the 
cache requirement is applicable. 

        
Virtual Memory Recommendations  
Á Double the amount of RAM, with a minimum of 512MB (Total for all disk volumes)  

 
Minimum Video Settings  
Á 800 x 600 Resolution, 256 colours  

 
Other Hardware  
Á Network interface card or a virtual network adapter card  
Á CD-ROM drive or Internet access to download and install the software 

 
Server Edition is also available for the following operating systems: 
Á Linux 
Á MAC OS X 

SYSTEM REQUIREMENTS  
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To install the Backup Professional Server Edition Client, simply run the installation file.  The 
Backup Client requires working space for the cache and temporary disk space for creating 
patches.  Note: Please ensure that the drive where you install the Backup Client has 
enough free hard drive space to store a copy of the selected files.  
 

For example, if you want to backup 1GB of 
data, there must be at least 1GB of free 
space available on the drive where you 
install the Backup Client.  Note: Plug-ins 
may also require additional working 
space; please consult the applicable 
plug-in documentation.  
 

Options available during the installation 
process depends on what your administrator 
enabled when the MSI file was created, 
ranging from advanced install settings, 
including the JRE, to specifying the install 
location.  The default install path is 
C:\Program Files\Attix5 Backup Professional 
SE.   

 

Click on Next to run through the available options and then Install to start the process.  The 
Installer will extract the files and install the Backup Client.  When the installation is complete, the 
message ñAttix5 Backup Professional has been installed successfully and will now load.  Click 
on OK to continue.ò will be displayed.  Click OK.   
 

When you open the Backup Client for the first time, the Setup Wizard will start automatically.  
You need to create an account for the Client on the Storage Platform before you can initiate any 
backups.   
 

When you open the Backup Client interface for the first time, the Setup Wizard will start 
automatically.  You need to create an account for the Backup Client on the Storage Platform 
before you can initiate any backups.   
 

 

The Backup Professional MSI installer also enables you to remotely deploy the Backup Client 
using your preferred desktop management solution, e.g. Microsoft SMS.  Use the Deployment 
Wizard and include the NameServer and Group settings in the MSI; with these settings 
populated, you can specify that the Backup Account must be created automatically during the 
install process.  Use the following command to run the installer: 
 

./BackupClientFileName_SE.msi PREPACCOUNT=Yes 
 

If you do not want to include the NameServer and Group details you can also specify it as 
additional parameters, these will override the default settings configured:  
Á SERVERIP ï The IP address of the NameServer 
Á GROUP ï Group Name 
Á CREATEKEY ï Group Create Key 

 

2. Installation 
______________________________________________________________________________ 

MSI INSTALL OPTIONS  
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The standard MSI parameters are also available.  A few examples are: 
Á /help ï Help information 
Á /quiet ï Quiet mode, no user interaction 
Á /passive ï Unattended mode, progress bar only 

 
MSI Notes: 

1. Backup Professional will use the Windows Computer Name as the Backup account 
name. 

2. The password and encryption keys are randomly selected during the account creation 
process. 

3. You are advised to install a Group Certificate to the specific Groups as the encryption 
keys are random.  Without this certificate you will not be able to connect to a backup 
account to restore any data, should the computer crash. The password can be changed 
in the Storage Platform Console. 

 
An example to deploy the Server Edition backup client: 
...\A5BPSE5.0.msi PREPACCOUNT=YES SERVERIP=SERVERNAME GROUP=GROUP01 
CREATEKEY=KEY021 /passive /quiet 
 

 
If any of the following steps are not visible, your backup administrator removed the steps when 
the MSI deployment file was created.   
 

Step 1 of 8: Supply the correct Storage Platform and group settings.  The Storage Platform 
address is the IP address or DNS name of the NameServer that authenticates you before you 
can backup or restore data.  The Group name specifies which group you will join and the 
Group create key is needed in order for the Backup Client to create an account in the specified 
group.  Click Next. 
 

Note: Ensure that you enter the correct settings. Contact your backup administrator if 
you are not sure about the settings.  

Step 2 of 8: If you are installing the software for the first time, select ñI want to create a new 
backup accountò.  If you have an existing account that you want to reconnect to select the "I 
want to reconnect to an existing backup account" option. Click Next to continue.  
 

Note: You cannot connect from different servers to the same backup account.  Each 
server must have a separate account. 

THE SETUP WIZARD  
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Step 3 of 8: Choose and enter 
your backup username, 
password and encryption key. 
The backup username and 
password can consist of any 
keyboard combination between 4 
and 20 characters. The 
encryption key can be any 
keyboard combination between 8 
and 56 characters. Click Next.   
 
Note: Do not forget your 
encryption key as you will not 
be able to retrieve your data 
without this encryption key. 
 

Step 4 of 8: Select the connection type that you want to use to connect to the Storage 
Platform.  Use the Configure Proxy button to specify any Proxy settings needed for 
communications to the Internet.  Click Next to continue.  If you select the modem/dialup 
connection, the next step will prompt you to supply the connection that you want to use. 

Step 5 of 8: In this step you can 
configure the automatic backup 
schedule.  The default backup 
time is 19h00, but you can 
change it to any time during the 
day or night.  It is advised to 
backup at night when the server 
is not in use.  The server must be 
powered at the time of scheduled 
backups, but you do not have to 
be logged in.   
 

Note: If you do not schedule 
any backups, you will have to 
manually backup your data. We 
strongly recommend that you 
run automated backups. 
 

Step 6 of 8: If you have limited space on the drive where the Backup Client is installed, you 
can move the Cache, Logs, Temporary folders and the selection database to another location.  
 
Note: always keep these folders and the selection database on the same drive/volume. 
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Step 7 of 8: You can select any of the available plug-ins in this step and click on Configure to 
enable and configure the plug-in(s).  Alternatively, you can access and configure them later 
from the Tools menu.  Note that these two plug-ins are shipped with the Backup Client.  Click 
Next to continue.  

Step 8 of 8: Confirm that the 
information you supplied is 
correct, and click Next.   
 
The Backup Client will connect to 
the Storage Platform and 
configure your account.  A 
message will be displayed to 
confirm that your account was 
created successfully.   
 
Click OK to close the message 
box.  Next, you must select files 
and folders, to create your 
selection list. 

 

 

The Backup Professional SE Service needs access to all files that must be protected.  If you 
have folder permissions enabled on your server, you have to ensure that the service is started 
with a user that has sufficient rights to access these folders, e.g. started with the administrator 
account. 
 

Everyone who has access to the Backup Professional Server Edition backup client will be able 
to restore files, whether they have file/folder permissions or not, so access to the server and the 
SE Backup Client must be controlled. 
 

You have two options to increase the security level in Server Edition: 
Á Enable the setting Prompt for password on restore in the Account and Security tab by 

selecting Options from the Tools menu.  With this setting enabled, users will not be able 
to restore any files without the proper account password. 

Á The second option is to set permissions to the Attix5 Backup Professional SE folder, to 
ensure that only authorised users can access the folder.  If you set permissions 
unauthorised users will not be able to run the Backup Client to modify the file selection or 
to restore files.  Note that you must still configure the SE service to start with a user 

that has access to the folder and to the protected files. 
 
 
 
 
 
 
 

SECURITY  ð ACCESS TO THE BACKUP  CLIENT  
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As from v4.1, the Backup Client will automatically receive software upgrades during the backup 
process, should there be an update available on the Storage Platform and if Auto-update is 
enabled for the particular Group in the Storage Platform Console.  Nothing needs to be 
configured in the Backup Client.   
 

Note that, after an auto-update, you must restart the Backup Client GUI before the new 
version will be visible. You are advised to keep the GUI closed, when not used. 
 

SERVER EDITION AUTO -UPDATE  
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The Backup Professional Server Edition (SE) service initiates automatic backups in the 
background at scheduled times.  You do not have to be logged in for the service to backup your 
data, as with any Windows service. 
 
If you are protecting files and/or folders with permissions, you have to ensure that the SE 
service is started with an account that has the required permissions to gain access to the files 
and/or folders. 
 

 
The SE Runner (the         icon in the system tray) monitors activity of the backup service and 
can also be used to select various options for the Backup Client.  An animated icon indicates 
that the service is busy with a backup process. 
 

 
 
If you right-click on the SE Runner you will see the following options: 
 
Open To open the Backup Professional Client where you can                                 

modify your backup selection, restore files and configure the backup 
schedule.  You can also double-click on the SE Runner to open the 
Backup Client. 

Backup Now With this option you can manually initiate the backup process without 
opening the Backup Client.   

Cancel Backup If the service is busy with a backup (an animated 5 icon), you can click 
on cancel to stop the process.   

Monitor Progress With this option you can monitor the status and progress of the process 
that the SE Runner is busy with at that moment without opening the 
Backup Client.  A small window is opened above the system tray and 
displays the current process and progress. 

Notifications Use this option to enable/disable Backup notifications.  Refer to the 
next section for more information. 

About About displays a window with the product details.  Click anywhere on 
the About window to close it. 

Exit If you click on Exit the SE Runner will be removed from the system tray, 
but it will not stop the Backup Professional service from running 
scheduled backups.  If you want to see the icon in the system tray 
again, open the Backup Professional Client. 
 

 
When the service is busy with a backup, you will notice that the system tray icon is animated.  
The Backup service must be running at all times otherwise backups (manual or scheduled) will 
not be able to take place.   
 
If you need to stop or start the Backup Service, open the Services window in the Control 
Panel, click on Attix5 Backup Professional SE and select Stop or Start from the toolbar.  The 

system tray icon is displayed with a red cross  when the service is not running. 
 

3. The Backup Service 
______________________________________________________________________________ 

SERVER EDITION RUNNE R 
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The Backup Client runs as a service, so it is difficult to flag important messages and warnings, 
e.g. when a backup failed.  
 
The system tray icon (runner) can display a number of notifications, once a backup has been 
completed. The following notifications are available:  
 
Á Backup successful (popup message 

displayed for 5 seconds) 
Á Backup successful with errors (message 

displayed for one minute) 
Á Backup failed (message displayed until 

the user clicks on it)  
 
When a notification is available, a popup bubble will be displayed with information, and the 
option to view the applicable log file by clicking anywhere within the bubble. The system tray 
icon will also flash a red X image if there were warnings or errors. 
 
Notifications are enabled by default and can individually be disabled by right-clicking on the 
system tray icon and then selecting the Notifications option. 
 
 
 

NOTIFICATIONS  
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Backup Professional Server Edition keeps your most valued data secure.  It allows you to select 
files and initiate backups, and to restore lost or corrupted files.  You can also find and restore 
files from previous backups and schedule automatic backups. 
 

 
 
While you are using the Backup Client, you may select Help from the Help menu, should you 
require any help.  This additional windowpane on the right of the window above, will guide you 
through the operation of the Backup Client. 
 
 
 
 

4. Backup Client 
______________________________________________________________________________ 
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How to Backup 

 
 
The next sections describe how to select files and folders for backup, how to add filters to 
folders to automate the file selection of certain file types, and how to backup your files to the 
Storage Platform. 
 

 

To select files that you would like to backup, click on the  Backup Selection tab.  The folder 
structure of your computer is displayed in the left-hand pane.  If you click on a folder, its 
contents will be displayed in the right-hand pane.  Subfolders are only shown in the left-hand 
pane.  Once a file or folder is selected for backup any changes, additions or deletions to that file 
or folder are automatically backed up. 
 
To select an individual file: Browse to the individual file that you would like to backup.  In the 
right-hand pane, right-click on the file and choose Select or click in the  box next to the file.  A 
selected file is displayed with a  green icon.  To deselect a file you can either click on the box 
again or right-click on the file and Deselect it.  Folders that have some files selected are 

displayed with a  green tint.   
 
To select an entire folder: Right-click on the  folder and select Include Folder.  You can 
also use the left mouse button to highlight the folder and then Include the folder from the 
Selection menu.  Included folders are displayed with a  green folder.  All files in the included 
folder and its subfolders are now selected for backup.  Any changes made within this folder or 
its subfolders will automatically be included as well.  To deselect a folder, right-click on the folder 
name and select Deselect Folder from the selection list. 
 
To exclude a file or folder: If an entire folder is included but you want to exclude a particular 
file or subfolder, right-click on the file or folder and select Exclude.  Excluded items are 

displayed with  red icons or  red folders.  Folders that have been selected but have some 
files or subfolders excluded are green with a red  tint. 
 
To verify the size of your backup, select Calculate Size from the File menu or click on the Size 
button in the toolbar.  If your backup set is larger than your allocated limit you have to reduce the 
size of your selection.  To remove files, right-click on a file that you want to exclude and click on 
Deselect.  Alternatively, you can ask your backup administrator to upgrade your account limit.   
 
Note:  The Backup Client compares your backup account size with the size of your 
backup selection at the beginning of the backup process.  The backup process will stop 
and an error message will be displayed if the selection size is over your account limit. 
 
If you do not want to wait for the next automated backup, you can select Backup Now from the 
File menu to manually start the backup process. 
 

 
You can use filters to automate the file selection of particular file types from a specific folder and 
its subfolders.  For example, a *.doc filter will include all existing Word documents, as well as 
any new Word documents that may be added later.  To add a filter to a specific folder, right-click 
on the folder, select filters and choose one of the available filters from the list.   
 

SELECTING FILES FOR BACKUP  

FILTERS  
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A few filters have been provided for you to start with.  You can create, modify and delete any of 
the filters.  To modify a filter, select Filters from the Selection menu and click on Edit filters.  
Select one of the filters and Add or Remove any of the file types.  The New filter option allows 
you to add additional filters.  Supply a name that describes the filter and then enter the file 
type(s). 
 

Example: AutoCAD users may want to only select their drawing files as the rest are generated 
by AutoCAD and do not need to be backed up. The filter could be called Drawings and the filter 
type would be *.dwg. 
 

Files that are included by applying a filter are displayed with the green selection icons with a 
blue checkbox, e.g.  for files, and  for folders.  Filtered files or folders cannot be deselected, 
but you can exclude particular filtered files or folders by right-clicking on the file or folder and 
then selecting Exclude.  A filtered folder with exclusions is displayed with a red  tint.  More 
than one filter can be applied to a specific folder.  To remove filters from a folder, right-click on 
the folder, select Filters and clear the checkbox next to the specific filter(s) that you want to 
remove.  
 

 

You may notice another group of icons in the Backup Client.  Dynamic Profiling selections, 
which can be specified by the Backup Administrator, are displayed with the following images:   

 for file inclusions,  for filtered inclusions and  for excluded files.  On folder level, the 
images are  for included folders,  for filtered folders, and  for excluded folders. 
 

 

After you have selected the files and folders for backup, you can manually initiate the backup 
process by selecting Backup Now from the File menu or by clicking on the Backup button in 
the toolbar.  You may close the Backup Client after you have started the backup process by 
clicking Hide.  This will not cancel the backup process and you can at any stage open the 
Backup Client to view the progress of the backup.  You can also monitor the backup progress by 
right-clicking on the system tray icon and selecting Monitor Progress.  Backup log information 
can be viewed in the Logs tab.  Backup entries are displayed in blue. 
 

Note:  The backup selection list is automatically saved every 30 seconds.  Right-clicking 
on the SE Runner and selecting Backup Now will not backup any files selected within the 
last 30 seconds.  You have to close the Backup Client or wait a few seconds before these 
changes will be saved. 
 

 

The Backup Client can try to resume a backup, if the previous request failed for whatever 
reason. If you select Backup Now from the File menu or you click on the Backup button in the 
toolbar and the previous backup was not successful, the Backup Client will prompt ñDo you 
want to resume the failed backup?ò with a 30 second countdown.  If you select Yes, the 
Backup Client will try to continue from where the process failed during the previous backup.  
Select No to initiate a new backup or Cancel to return to the Backup Client.  Note: a new 
backup will be initiated after the countdown has elapsed.  
 
 
 
 
 
 

PROFILED SELECTIONS  

MANUAL BACKUPS  

BACKUP RESUME  
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Backup Professional Server Edition supports multiple thread backups.  Files are transferred to 
the Storage Platform using a second thread as soon as they are compressed or patched while 
the backup process continues to compress/patch files using the first thread in the background. 
This improves the total backup speed significantly. 
 

Note: this functionality is enabled by default.  To disable this feature please refer to the 
Advanced Options section later in the user manual. 

MULTIPLE THREAD BACK UPS  
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How to Restore 

 
 
The next section describes how to select the files that you want to restore, how to search for 
specific backed up files, and finally how to restore files from the Storage Platform. 
 

 

Open the  Restore tab.  From this tab, you can gain access to your backed up files. Your 
latest backup is shown in the Last Backup folder.  If you expand the Previous Backups folder, 
the Backup Client will connect to the Storage Platform and retrieve a list of all previous backup 
dates. 
 

Select the files and/or folders you want to restore.  To select a single file, right-click on the file 
and click on Select or you can click in the  box next to the file.  To select an entire folder, right-
click on the folder and then choose Select folder.  Selected files are displayed with  green 
icons.  To start the restore process, select Restore from the File menu or click on the Restore 
button in the toolbar. Note: Automatic backups are disabled during the restore process. 
 

The Backup Client will prompt for a restore location to where the file(s) must be restored.  If you 
select Original location, the files will automatically be restored to the same location from where 
they were backed up.  Note: If you choose this option, the restored files will overwrite any 
existing files with the same name in that location.  You will be warned before the Backup 
Client overwrites any files. 
 

If you do not want to overwrite the current copy of these files, select the Folder option.  The 
default path is a Restore subdirectory in your user account (home) folder. You can also Browse 
to another folder if you want to restore the files to a different location. 
 

Restore Options: 

Recreate directory 
structure 

By default, the folder structure is recreated in the restore folder.  If 
you want all files to be restored to one location, uncheck the 
Recreate folder structure option.  Note: If you are restoring files 
from different folders with the same filename, you must recreate 
the folder structure or they will overwrite each other.   

Restore empty 
folders 

You can choose whether empty folders must be recreated if the 
Recreate directory structure option is enabled.   

Overwrite files Enable this option if you do not want the Backup Client to prompt you 
before overwriting an existing file. 

Use compression 
(faster over the 
Internet) 

Tick the Use compression option to enable compression.  With this 
setting enabled, the Storage Platform will compress the files before 
transferring them to the Backup Client.  Note: You are advised to 
always enable this setting if you have a slow connection to the 
Internet as the files are smaller with this option enabled. 

Restore file and 
folder permissions 

Disable this option if you do not want to restore the file and folder 
permissions; typically used after a complete server failure to restore 
files before users accounts are re-created. 

Restore directly to 
target location 

Enable this option to write files directly to the specified folder without 
using a temporary working folder. The restore process is faster using 
this option, but file level resume is not possible and a complete file 
will be resent should there be a communications error between the 
Storage Platform and the Backup Client during the file transfer. 

 

Restore log information can be viewed in the Logs tab.  Restore entries are displayed in green. 

HOW TO RESTORE FILES  AND FOLDERS  
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The Find files in Backups option enables you to search through your previous backups to find 
a specific file.  You have the option to do a local search from your last backup, or you can 
connect to the Storage Platform to search through your previous backups. 
 
To search for a file from your latest backup, select Find files in backups from the File menu or 
click on the Find button in the toolbar.  Enter the filename in the textbox and click on Find.  
 
Example: If you enter help in the textbox, the Backup Client will display a list of all backed up 
files from your last backup that contain help in either the filename or the folder.   
 
Note: You can use the * and ? wildcards for advanced search queries to find the files that 
you are looking for.  
 

 
 
To search for files from previous backup sets, enable the Search through previous backups 
on server checkbox.   
 
File dates can also be specified and you can and limit the number of results that must be 
displayed.  Note:  The Backup Date is used if you enable Search file dates and not the file 
create or file modified dates.   
 
To restore the located files, select them individually and then click on the Restore button. 
 
 
 
 
 
 
 
 

FIN DING FILES  
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Options and Settings 

 

 

From this Tools menu item you can view and configure the primary Backup Client options and 
settings.  To open this section, select Optionsé from the Tools menu.  The various options and 
settings are grouped in the left-hand pane according to their functions.  
 

Note:  Please read through this section carefully before you change any of these settings.  
Incorrect settings could cause serious problems or even stop the Backup Client from 
protecting your data. 
   

 

Account Information 
This section displays your backup account information as it is configured in the Storage 
Platform.  You can use the Retrieve Settings button to update your account settings from the 
Storage Platform.  This tool is useful to verify that your account limit has been modified after 
requesting a change from your Backup Administrator, or to update Backup Group Profiling 
settings.  
 

Account Setup 
If you need to change your password or encryption key, select either the Change Password or 
Change Encryption Key buttons.  Changing your encryption key involves intensive processing 
on the Storage Platform and may take several minutes.  It should therefore not be done unless 
your encryption key was compromised.  
 

Security Settings 
The Security window allows you to select whether the Backup Client should remember the 
backup account password when running a backup or a restore.  There are three options 
available:  
 

Á Remember password for backup and restore: The Backup Client remembers the user 
password when doing a backup or restore.  This is the default setting.  

Á Prompt for password on restore: The Backup Client prompts for the user password 
during the restore process.  

Á Prompt for password to open the backup client and to restore: Use this option to 
enable access control.  The Backup Account password must be supplied before you will be 
able to open the backup client to change the backup selection or any of the application 
settings.  Backups will continue as normal. 

 

 

Connection Settings 
In this section, you can change the connection that the Backup Client must use to connect to the 
Storage Platform.  You can choose between a network/permanent or dial-up connection. 
 

The Dial-up Settings button is enabled if you select the Dial-up option.  Click on this button to 
select an existing dial-up connection configured on the computer, and supply the username and 
password for that Internet connection. 
 

Proxy Server 
Enable the Use a proxy server for you network or dial-up connection checkbox if you connect to 
the Internet via a proxy server, and supply the necessary information. 

 

ACCOUNT AND SECURITY  

CONNECTIONS  
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The Backup Client can be scheduled to backup your selected files and folders automatically.  
Note that if you configure the Backup Client to backup at night, the server must be powered, but 
you do not have to be logged in.  The backup schedule can be changed by selecting Automatic 
Backups from the Tools menu or by clicking on the Automate button in the toolbar.   
 

Use the Daily Automatic Backups section to configure a once-off daily backup.  The 
Advanced Schedule can be used to specify additional backups.  Backup logs can be viewed in 
the Logs tab.  Backup entries are marked in blue. 
 

Note: You are advised not to disable automatic backups as you will then have to 
manually backup your files.   
 

 

Working Folders 
If you have limited space on the 
drive where the Backup Client is 
installed, you can move the Cache, 
Logs, Temporary folders and the 
selection database to another 
location.  The Temp folder is used 
for temporary workspace when the 
files are patched, compressed and 
encrypted, the Logs folder stores 
all backup and restore logs, and 
the Cache folder keeps a local, 
compressed and encrypted, copy 
of the selected files for a specified 
amount of days.  The selection 
database compares the latest 
backup selection with the previous 
backup to determine the changes. 
 

Note: Always keep these folders 
and the selection database on the same drive.  If you move these folders and the 
database to a network share, please ensure that the Backup Client has the correct 
permissions to reconnect and write to that share. 
 

Cache 
When modifications are made to a file, the Backup Client only transmits the changes to that file, 
as opposed to transmitting the complete file again.  This is accomplished by keeping a 
compressed copy of the file in a local cache and then using a sophisticated patching technique 
to extract the difference between the file in the cache and the one ready to be backed up. 
 

Files are only kept in the cache for a certain amount of days.  Files are added to the Cache 
folder if the file was modified within the Days to keep files in Cache window.  Once a file has 
been flushed from the cache, a full copy must be backed up when any modifications are made 
to the file.  The longer files are kept in the cache, the better the chance of only transmitting 
patches instead of full copies and thus reducing the amount of data that needs to be transmitted.  
If you have limited disk space, you may want to consider shortening the time files are kept in the 
cache. 
 

BACKUP S CHEDULE  

DISK USAGE  
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Note: If you select 0 days, patching is disabled, any files in the Cache folder will be 
deleted, and complete files are backed up to the server during each backup.  
 

To delete the current cache, use the Clear Cacheé button.  If you delete the cache, full copies 
of your selected files will be re-sent to the server during the next backup.  You may notice that 
the Backup Client will log the message Doing monthly cache cleanup once a month.  This 
maintenance task is to ensure that the cache folder is up to date by deleting any files that fall 
outside the Days to keep files in Cache window. 
 

 

Processor Usage and Disk Access 
The Backup Client uses a fair portion of the available processor power to patch, compress and 
encrypt files while during the backup process.  If you use the computer at the same time, you 
may experience some performance deterioration. You can lessen this effect by lowering the 
Processor Usage. 
 

Disk Access is another setting that you can modify to limit performance deterioration.  If this 
setting is set to high, the Backup Client will continuously use all available disk access to write to 
the disk, ensuring that the process completes as fast as possible.  The process will take longer if 
you lower this setting but your other applications will function without any interruptions. 
 

Limits 
Outgoing transfer limit - The outgoing transfer bandwidth can be limited (in kBytes/second) in 
case you need to allocate only a certain amount of bandwidth to the Backup Client.  
 

Backup size restriction - You can limit the total amount of data that may be transferred during 
each backup.  Note: If you enable this option, it may take several backups before all your files 
are backed up to the Storage Platform.  This feature is especially useful if you have a poor 
Internet connection and you encounter problems with transferring large backups. 
 

Backup cycle - The Backup Client can be configured to cycle the backup process until all 
selected data has been transferred to the Storage Platform by automatically initiating 
subsequent backups. This setting can only be enabled if a backup size restriction has been 
specified. 
 

 

System Exclusion Filter 
The System Exclusions Filter enables you to specify any file types that you want to exclude from 
the backup selection list.  For example, to exclude all MP3 and AVI files, specify *.mp3;*.avi in 
the text box.  Separate entries with a semicolon. 
 

You can also exclude files by enabling the Do not back up files older than: checkbox and 
specifying a date.  Note that the Date Exclusions Filter uses the file modify date as reference 
and not the file create date.  
 

No Compression Filter 
Compression is not effective on all file types as some files may already be compressed or 
cannot be compressed at all.  The Backup Client could spend some time and processing usage 
to try and compress these files.  This filter enables you to specify a list of file extensions that 
must not be compressed during the backup process.  The list of file types already specified are 
types known for not compressing well. 
 

PERFORMANCE AND LIMI TS  

SYSTEM  FILTERS  
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Backup Professional enables you to specify File and Folder Exclusions.  These files and folders 
are excluded from the backup selection, no matter where they are located on the available 
drives or volumes.  Note: these entries are case sensitive; you have to ensure that you 
specify exact matches. 
 

To add an exclusion, click on Add folder or Add file, specify the name and click OK.  Folders 

are displayed with  and files with .  To modify any of the exclusions, select the entry and 
click on Edit, or double click on the exclusion name.  To remove an entry, select the file and 
click Remove. 
 

Click on Ok at the bottom of the Exclusions tab to save your changes. Excluded files are 
displayed with  and folders with  in the Backup Client. 
 

 

Options and Retries 
The Backup Client can be configured to Always connect to the Storage Platform during each 
backup to update its last backup date stamp, even if there were no changes made to the backup 
set.  With this setting enabled, the Storage Platform will always be up to date with the latest 
backup date. 
 

SSL Encryption can be disabled 
to improve the transfer time during 
the backup and restore processes.  
Note: By disabling SSL 
encryption, you are lowering the 
security level when transferring 
files to and from the Storage 
Platform.  This setting should 
only be used in a secure 
environment. 
 

Complete compression/patching 
before sending data to the 
Storage Platform.  Enable this 
option if you do not want to make 
use of multiple thread backups to 
speed up the backup process, 
typically needed when using a dial-
up account.  With this setting 
enabled, the Backup Client will 
compress all new files and patch all 

modified files before starting to transmit data to the Storage Platform.   
 

Verify account limit before compression/patching.  With this setting enabled, the Backup 
Client verifies the backup account limit on the Storage Platform before starting with the 
compression and/or patching processes.  It is useful to flag account limit issues before starting 
with these processes. 
 

Enable Volume Shadow Copying to backup locked files enables you to backup locked files 
without using third party open file management software.  This is currently only available on 
Windows XP, Windows 2003 Server, and Windows Vista Operating Systems.   

 

GLOBAL  EXCLUSIONS  

ADVANCED O PTIONS  


